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Iterative Fourier Transform Algorithm (IFTA) Design
via Module



Abstract

—
[ L] 1% Module
Source Code A

A
| Bl 36 Optimized Output Freld

P

(
(\&EIC HTTRANS
\‘.../

The Iterative Fourier Transform Algorithm
(IFTA) is a powerful tool to perform structure
design for diffusors, beam splitter and beam
shapers. In this Use Case we will
demonstrate how to control the design tool by
a programmed module, providing a flexible
workflow for the user to operate the IFTA even
when using VirtualLab Fusion in batch mode
or in a python environment.




This Use Case Shows ....

How to use a programmable module to perform an IFTA - design.
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Source Code Advanced Settings -
20 using VirtuallabAPI.Core.StandardTransmissionDesign; j‘
21 using VirtuallabAPI.Core.Threading;
22 =N E=R X
23 namespace OwnCode { Light View Data View
24 public class VLModule : IVLModule {
25 //the path where all the data is located
26 I string pathofIFTAInputData = @"D:\Data\IFTA Example"; M 0.0273
27 //file name of the IFTA document which should be loaded from hard disc ! £
28 string filenameIFTA = "Iterative Fourier Transform Algorithm Optimization.dp"; £
//file name of the target pattern that shall be load into the IFTA T ]
I string filenameTargetField = "LT_Logo.ca2"; b=
//define filename for storage of merit function values
string filenameMeritFunctionValues = "Result.txt";
//define number of steps for each iteration
int numberSteps_PhaseSynthesis = 25;
int numberSteps_SNROptimization = 50; ~
int numberSteps_SoftQuantization = 100; 4
int numberSteps_SRNforQuantization = 5000; £ (
= 1
5 LIGHTTRANS 00136
bool limitScaleFactor = true; 2
double scaleFactorLimit = 1; 3 \
public void Run() { -648.81 pm
{,’load IETA Snom har‘d dlSC‘ = 2 2 2 Globally Polarized Harmonic Field
DesignAlgorithmHandler design = DesignAlgorithmHandler.Load(Path.Combine(pathofIFTAInputData,
//error handling |
if (design == null) { E
Globals.DataDisplay.LogError("IFTA could not be loaded!"); £
return; [ | 8
5 } 3
21 = &
4 4 6.64E-7
-200.56 mm 200.56 mm
0 Errors 5 Warnings
Thread terminated by Exception: A running Iterative Fourier Transform Algorithm Optimization cannot be cloned. Ln37 Ch42 Globally Polarized Harmonic Field Amplitude | Zoom: 0.55805 | (801; 750)




Design Task

For a detailed
discussion of the task,
please see:

detector plane

Diffractive Diffusor to

-------------------- Generate a LightTrans
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input field
» fundamental Gaussian
» wavelength: 650nm
 diameter (waist): 1mm
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4-level phase
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target pattern
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https://www.lighttrans.com/index.php?id=234

The Module — Preparations |

namespace OwnCode { "
public class Vitodule : IVltiodule { Here, the path of the folder, where the OS- and DP-files are saved needs

//the path where all the data located
string pathofIFTAInputData = @"D:\Data\IFTA Example";

//file name of the IFTA document which should be loaded from hard disc to be deflned-

string filenameIFTA = "Iterative Fourier Transform Algorithm Optimization.dp";

//file name of the target pattern that shall be load into the IFTA \’

string filenameTargetField = "LT_Logo.ca2 > DieserPC > Data(D:) » Data » IFTA Example

//define filename for storage of merit function values
string filenameMeritFunctionValues = "Result.txt";

is

leuer Ordner

Name & Anderungsdatum Typ GroBe
Iterative Fourier Transform Algorithm Optimization 04.10.2023 11:50 DP-Datei 20KB
LT_Logo 04.10.2023 13:44 CA2-Datei 4KB
¢ Module_Pregramming of Module_wParameterAccess e — ———
l38: Loge ‘E’ H.—Eﬂ
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desien NUmLESNRPhase - numberSteps, SNROp imisation; Please note, that the sampling
gn_NumTESHRQuant = numberSteps_ SRNForquant ization parameters of the desired
S output field must match the

s sampling specified in the IFTA

(DP)-file, otherwise an error | —-—— T
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The Module — Preparations Il

namespace OwnCode {
public class VL

L " where a
string pathofIFTAI

file name of the

ing filenameIFTA
e na of t rget
string filenameTargetField

//define number of steps for each iteration
int numberSteps_PhaseSynthesis = 25;
int numberSteps_SNROptimization = 50;
int numberSteps_SoftQuantization = 100;
int numberSteps_SRNforQuantization = 5000; _J

bool limitScaleFactor =
double scaleFactorLimit

Specification Design  Analysis

public void Run() {

= .Load(Path.Combine(pathofIFTAInputData, filenameIFTA));
error nar
if (design

.DataDisplay.LogError("IFTA could not be loaded!");
return;

.Load(Path.Combine(pathofIFTAInputData, filenameTargetField));

error hand g
if (caSignalField == null) {

.DataDisplay.LogError("“Signal could not be loaded!");
return;

-

set al field to IFTA document

design.ConstraintSpecification.SetSignalFieldAndSignalRegion(caSignalField.Field, null);

a ne number of steps

design.NumItSPO = numberSteps_PhaseSynthesis;
design.NumItSNRPhase = numberSteps_SNROptimization;
design.NumItSoftQuant = numberSteps_SoftQuantization;
design.NumItSNRQuant = numberSteps_SRNforQuantization;

for limit scale factor

set parameter

design.ConstraintSpecification.LimitScaleFactor = limitScaleFactor;
design.ConstraintSpecification.ScaleFactorLimitGoalEff = scaleFactorLimit;

s from design document

sPara = new H
(design.ConstraintSpecification.SamplingPoints,
design.ConstraintSpecification.SamplingDistance);

Design Method  Iterative Fourier Transform Algorithm Approach v Transmission Set Shov
Design Steps Number of Iterations
B Generate Initial Transmission Method  Backward Propagated Desired Qutput Fielc v
@ Signal Phase Synthesis 25 (] Soft Introduction of Transmission Constraint
] SNR Optimization for Phase-Only (] Omit Final Transmission Projection
Transmission o (] Soft Introduction of Transmission Constraint
@ Soft Quantization 100 [[] Create Transmission Animation Options
(] SNR Ogtirpization for Quantized [] Create Output Field Animation Options
Transmission 5000
[] Show Final Transmission and Output Field

Logging

Progress in current design step

[] Enable Logging

Configure
Show Diagran

Start Design




The Module — Preparations Il

OunCode {
she pah sheve al S 4t o Tonsidi 7 [ = 39: D:AData\..\Iterative Fourier Transform Algorithm Optimization.dp

pathofIFTAInputData

: Specification Design Analysis
filenaﬁeIF'h

Fil;ﬂame'a:‘ge: 1 P .ca2"; : Input Field Propagation
Wavelength 649,82 nm Type of Propagation 1f-/2f-Setup s
i".;ﬂueger‘éte;srjr’ha_;;;j,'rrwthesi_::: Z:;v;; o o Constant Input Field Focal Length 1m
i numberSt _SNROptimi ion = 50;
umbers = 100; Arbitrary Input Field Set Show. 3}
int numberSteps_SRNforQuantization = 5000; " Embed Frame Width —0
bool limitScaleFactor = true; : 2 1
double scaleFactorLimit = 1; TR Gan Pixelation Factor
ex i Simulate Pixelation Exactly
A from hard disc Sampling Points 801 750
design = .Load(P .Combine(pathofIFTAInputData, filenameIFT, 3 3
error handling 2 5 Qutput Plane Sampling
if (design == null) { Sampling Distance 1.62 um = 1.73 um
.DataDisplay.LogError("IFTA d not be "5 Samp“ng Points 801 x 750
y Type of Continuous Phase-Onl v Sl S
¥ T iesion Y Sampling Distance 500.78 pm x 500.83 pm
mplexAmplit Téésigr4alField = .Load(Path.Combine(pathofIFTA\nputData, filenameTargetField)); Number of 16 Field Size 401,13 monce 375.6¢ mmm
Quantization Levels Use Angular Coordinates
null) {
lay.LogError( not be )5 S 3
~ByeLegkrrant Qutput Field Requirements
- Desired Output Field Set Show Limit Stray Light
Sp ;i;‘icat;\;n: Sé:>igna‘ ieldAndSignalRegion(caSignalField.Field, n\l1); Maximum Relative Intensity 10%
2 Optimization Region Set Show of Stray Light ————
design. = numberSteps_PhaseSynthesis;
design.Nu SNRPhase = numberSteps_SNROpt ation; Sa zation R 0 Desire ut Fiel

design.Nu SoftQuant = numberSteps_SoftQuantization; : = - R - D Limit Feature Size

design.NumItSNRQuant = numberSteps_SRNforQuantization; °A||OW Phase Fr jom

B Minimum Feature Size 1 pum
design. : Slcw Scaéeedow Maximum Stray Light Intensity
design. i it ST 7
eSTEn N ™ Limit Scale Factor According e Freqyuencies 0%

to Goal Efficiency 100% 9
ameters sPara = npli
sPara = ne LALSS
design.ConstraintSpecification.SamplingDistance);




The Module — Loading the Target Field and IFTA Parameters

g FilenameTargetField = "Desired Out 6 38 ca2”; In the first step, the previously specified IFTA DP-file will be
BSnER o csienttes: & S loaded. All information about the optical setup will be
extracted from this file. To perform the IFTA per module, a
new DesignAlgorithmHandler is created.

public void Run() {
//load IFTA from hard disc

DesignAlgori Handler design = DesignAlgorithmHandler.Load(Path.Combine(pathofIFTAInputData, filenameIFTA));

{/error.hanfii:ﬁ . . . . .

1" (Globats.pataDisplay: Logerron( IFTA could not be losdedi®); In the next section, the desired output field is loaded from file,
return; . . .

) which was defined above. Please note, that the sampling

//load?lgn?l .ieigsignalField = ComplexAmplitude.Load(Path.Combine(pathofIFTAInputData, filenameTargetField)); para‘meters Of thls flle mUSt matCh the Sampllng SpeCIerd In

Hhsnose, inoilog the DP-file, otherwise an error will occur.

if (caSignalField == null) {
Globals.DataDisplay.LogError("Signal could not be loaded!");
return;

}

//set signal field to IFTA document —
design.ConstraintSpecification.SetSignalFieldAndSignalRegion(caSignalField.Field, null);

//define number of steps

des LutwTioRo MMEleps Rty Next, the parameters, which were defined above are loaded into

des?gn.NumItSNRPhase = numberSteps_SNROptimizetio?;

o1, AT SHMEONRE = MUBBeFSteps. SANFOROIANEA zaEions \ the DesignAlgorithmHandler. In this example, only the Limit

//set parameter for liit scale factor _ Scale Factor According to Goal Efficiency factor is specified, but

des?gn.Constra%ntSpec?ffcat?on.L1m1tScaleFa§t9r = limitScaleFactor; . .

design.ConstraintSpecification.ScaleFactorLimitGoalEff = scaleFactorLimit; - a” Other parameter Of the IFTA document Can be adapted in the
same way.




The Module — Performing the Design

//read samplmg parameters from des:Lgn document -

nalls o — To visualize the results appropriately, the sampling parameters defined in the
s ign. .n pec%f}cat:}on.Sampl%ngpc.nnts, o . .
design.ConstraintSpecification.SamplingDistance); | DGSlgnAlgorlthmHandlel’ are eXtI'aCted

if (design.Transmission != null) {
//show initial transmission —
4._A::~:'w_e:-:w: _i'.‘.n e 1n1tlalTr‘ansm1551on = new ComplexAmplitude(design.Transmission); . . . ey . . . .
initialTransmission.SanplingDistance = sPara.Samplingdistance; — This section outputs the initial transmission, if one has been defined.

Globals.DataDisplay.ShowDocument(initialTransmission, "Initial Transmission");

¥

//perform design

put 1terat10nData0utput = new IterationData0

Corker = nok WorkerThecad (Deslgn", TaLL, malL, b)) } This command performs the IFTA design, finally.

design.DoAllSelectedSteps(1terat10nData0utput, worker);

lor

//shou optlmved transmission
= de optimizedTransmission = new Ct exAmplitude(design.Transmission);
optlmlzedTransm1551on SamplingDistance = sPara. Samphnngstance,

s.Dataisplay. Showbocument (optimizedTransaission, “Optimized Transmission"); Here, the transmission function designed by the IFTA is extracted and output.
e s : The output is the same as if clicking the Show button on the Design tab.

[R0~6 D\Date\..Alterative Fourier Transform Algorithm Opfimization.dp =

Specification Design  Analysis

Design Method  Iterative Fourier Transform Algorithm Approach v Transmission Set [ Show |
Design Steps Number of Iterations
2o -, | |
/ersionEff, n Generate Initial Transmission | | Method Backward Propagated Desired Output Fielc ﬂ

10



The Module — Analysis of the Result

Sanm gParameters

sPar‘aOutPutFleld new Sampl
//d951gn ConstraintSpecification.
eld cfOutputField =

//shou optimized transmission

Comp

double conversiontEff =
double uniformityError =
//log conversion efficiency

operty.Percentage));

Pt rty.Percentage));

.DataD

sParaOutPutField

design.

new Samplin

s(design.

rs();

onstr‘alntSpeuﬁcatlon SamplingPoints,

design.ConstraintSpecification.SamplingDistanceOut);

DoForwardProp();

2 ude resultField = new Comple D
r‘esultFleld SamplingDistance = sParaOutPutFleld SamplingDistance;
yals.DataDisplay.ShowDocument(resultField,

DataDlsplay LogMessage("Conversion Efficiency =

DataDlsplay LogMessage("Uniformity Error = " + Ph

litude(cfOutputField);

"Optimized Output Field");

design.GetConversionEfficiency(cfOutputField, sParaQutPutField);
design.GetUniformityError(cfOutputField, sParaOutPutField);

ts.FormatPhysicalUnit(uniformityError,

s.FormatPhysicalUnit(conversionEff,

After the design was finished, the module will automatically perform an analysis.
For this purpose, the optimized result field is calculated and output, similar to the
option Show Output Field in the IFTA document.

The DesignAlgorithm
Handler provides
various performance
parameters which can
be output: Here, just
the Conversion
Efficiency and
Uniformity Error are
used.

& 33: D:\Data\..\lterative Fourier Transform Algorithm Optimization.dp

Specification Design Analysis

=le s

y

() window Efficiency [26]
Conversion Efficiency [%]
(] signal-to-Noise Ratio [dE]

18 Uniformity Error [%]
(] Relative Zeroth Order Intensity [%]
Zeroth Order Efﬁciency [3e]
7] Maximum Relative Intensitv of Strav | iaht 1241

64157

93.34.

=

T

Show

Recalculate
Output Field

Show
Optical Setup

Scale Errors for Phase-Only Transmissions
[[] Impose Linear Scale Error by Scale Factor

O Impose Binary Mask Scale Mask #1 (pi)
— Errors by Given Scale Factors 4. 45 1pif2)

Scan Scale Error Range

From 0.9

Modified
Scale Factor

Linear ™,

Mask £3 (pi/4} 1
Mask #4 (pi/8) 1

Number of Steps 1"

— Create Output Field

To 1.1 O

Animation

Linear |ConvEff[%] |UnifErr [3¢]

Recalculate
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The Module — Export Output Data

ssmplingpoirts, Finally, the resulting performance parameters are output in the Messages tab
SamplingDistance); . .
as well as exported in a text file.

s nonaleion, “tmitiol Beansaissionl; [2023-10-04 15:38:54] Compile successful
: [2023-10-04 15:38:54] Module started
e N [2023-10-04 15:39:20] Total Time: 00:00:24.9593766
worker = new WorkerThread("Design", null, null, null); [2023-10-04 15:39:21] Conversion Efficiency = 63.799 %
design.DoAllSelectedSteps(iterationDataOutput, worker); [2023_10_04 15:39:21] Uniformity Error 2 93.628 %
. smission = new (design.Transmission);
optimizedTrans tance = sPara.Sampling > DieserPC > Data(D:) » Data » IFTA Example v G IFTA Example durchsuchen

.DataDi ay.ShowDocument(optimizedTransmission, ' ransmissic A
sParaQutPutField = new A 3
sParaOutPutField = new .Sampling| Name Anderungsdatum Typ GroBe
.SamplingDistanceQOut);
esig tratntSpecliilcation: e Exceptions 04.10.2023 12:47 Microsoft Edge HTML D... 472 KB
cfOutputField = design.DoForw
S B iterative Fourier Transform Algorithm Optimization 04.10.2023 15:29 DP-Datei 352 KB
resultField.SamplingD =
.DataDisplay.ShowDocument (resu 1d, "0 Output Field"); B 7 Logo 04.10.2023 13:44 CA2-Datei 14KB
double conversiontEff = GetConversionEfficiency(cfOutputField, sParaOutPutField); 5 : S
nifo Error n.GetUniformityError(cfOutputField, sParaOutPutField); |& Module_Programming of IFTA Modu Q’ D:\Data\IFTA Example\Result.txt - Notepad++
.DataDisplay.L ncy = " + .FormatPhysicalUnit(conversi§nEff, ﬂ’ Result File Edit Search View Encoding Language Settings Tools Macro Run Plugins Window
.Percen > \ -—— i
i - &h [ 4 » R b RER = = W
.DataDisplay.Log! " .FormatPhysicalUnit(uniformityErrpr, 0o & H \-i 9 0 4 H_I n 2 c | n a !X = 1 ie J l_\:l k )

.Percentage));

BResukmm]

S5 = I Conversion Efficiency = €3.799 %
- The name of the 2 Uniformity Error = 93.628 %
//define path for storing merit functions Output flle haS been

string filenameMeritFunction = Path.Combine(pathofIFTAInputData, filenameMeritFunctionValues);

//check whether file already exist 11

if (File.Exists(filenameMeritFunction)) { SpeCIerd a-t the
File.Delete(filenameMeritFunction);

} beginning of the
s.WritelLineToLogFile(filenameMeritFunction, "Conversion Efficiency = " + mOdule (pIS. see

calUnits.FormatPhysicalUnit(conversionEff, PhysicalProperty.Percentage));
s.WritelLineTologFile(filenameMeritFunction, "Uniformity Error = " + page 5)




Results — Output Original Field
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Phase
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